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1 B KREEZE 2 #E (Purpose and Scope)

2T R S E L 2%t (Java filY) Advanced Java-based Multi-dimensional Display
System (DA T A 24 ~ IMDS) fyRffiifE " i RGERAREETE ) R — HE
FEEHY H Y Ryl R E R A 25 7y [ 7 U E - DA ZZ A RR B FE A H &
EH o EFERNTUESMNIENEHIE R - HEE YR AR AR A IMDS 484
AOAWS ZHHYRSLE

The Advanced Java-based Multi-dimensional Display System (JMDS) is a deliverable of the
Advanced Operational Aviation Weather System (AOAWS) Project for the Civil
Aeronautics Administration (CAA). The goal of the system is to present weather information
in an easier-to-understand fashion for use by the aviation community on a daily operational
basis. The JMDS allows users with internet access to view weather information provided by
the AOAWS system both inside and outside of the CAA.

IMDS BB 2 53 BB I T e A
AN LS MTSAT (522208 - AR i S pUBE ) P B e T 2
BT MR - 22 s IS -

FESZRHIE  SHIES) Gk  HEPRIE « AL - BUKEL TITAN 2852 &
BRI -

The JMDS weather products include the following types:

Real time data: MTSAT satellite data, Meteosat satellite data, Radar mosaic from the Central
Weather Bureau and Radar data from Tao-Yuan International Airport, Airport surface
observational data, and aircraft reports.

Forecast data: winds, temperature, freezing level, relative humidity, turbulence, icing and
TITAN Storm Tracks.

IMDS [FEIls B 1A FHAER BN ER e (WP E ~ BB - il - TR
FEATE R R BEUR A [F] — (Bl n b)) YZHRE - DAFITRSSHERIIER -

The JMDS also has the capability of overlaying data (such as displaying a terrain map,
airport navigation sites/points, forecast winds, and observational data) over a selected

product, which can be utilized to support decision-making analysis.

IMDS PAE KoL E R = 4 R VUSER SRR i > BRI TR 22 [ G =4
B - e RIRECE R A B E E I mE - HIMLEAEEAITIEE
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The JMDS uses graphics and text to display 3-dimensional and 4-dimensional weather
products. It can show 3-D data by the flight level. It can also display vertical cross sections

for a selected flight route. In addition, it has a movie feature.

IMDS EL -4 E 22 R AR %54 > HAgHE By
http://aocaws.caa.gov.tw/htdocs/projects/aoaws/jmds/ °

The JMDS is installed on the AOAWS web site and can be accessed from

http://acaws.caa.gov.tw/htdocs/projects/aoaws/jmds/.

AT H Y Rsii IMDS S IATIRE AR S BB T3 - DUE R FEE IR EA 4R
Z 2% o SESIRART H #k DAE &R S E 1 2 20 -

This document is intended to provide the user with an overview of the functionality of the
JMDS. It also provides some operational illustrations for users. Please see the Table of

Contents for the key topics of each chapter.
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2 JMDS rEfEIRE (JMDS Hardware Environment)

JMDS YRS F KRS LS 1024*768 fiftiTfE 2 4glEl -k fo s 5 - 1GB FVELIEAS & 25MB
BRI ZS ] F 2R 22855 IMDS 22K - {824 IMDS BERAY RS mhis 2 £ /) 256 Kbps U4
HEE o

The JMDS hardware requirements are at minimum 1024*768 resolution graphic cards and
monitor, 1GB of memory, and 25MB of hard drive space for installing JMDS software.
Minimum bandwidth of 256Kbps is required to transfer the JMDS weather products.
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3 JMDS #gEIREE (JMDS Software Environment)

JMDS ZE5% Java 6.0 iDL F 27 FEA o Java T {7 http://java.com &k o Java o[ fF & T
HSTEZE 280 22485 - EE AR Windows ~ Linux 2 MacOS X -

The JMDS requires Java 6 or newer to run. Java can be downloaded from http://java.com.

Java can be installed on nearly all major operating systems, including recent versions of
Windows, Linux, and MacOS X.

IMDS EZE S AR E ) - 25 4R A Qi es - RIZEAE Java S| S Y4
B EseE T e B AR EIR ES o Java —fAE KISEI B 25358 K H BN AR HARE 5 E -
(B AR A SRS A R REHRF gl ] 2 JH 2 B AR B EE

The JMDS must be able to access the network to gather data. If a proxy server is used for
internet access, the proxy server must be configured in the Network portion of the Java
Control Panel. Java will often automatically configure its network settings based on browser
settings, but if network problems are encountered the Network settings may need to be
changed.
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4 JIMDS #/EERBH (JMDS Operational Guide)

= 55— KA > IMDS grgin—(E L R & 2T JIMDS - ElERE R EfEN
JMDS EACE YRS R H A EHYZOR » B #T(Run)"1% » G&UR Tk IMDS fEfTE
AP - IMDS JE R E#E MR T -

When the JMDS is first started, a window shows asking whether you want to run the JMDS. This
window should indicate that the JMDS has been verified as being from a trusted source. Click
“Run”, after which a window showing application download progress is shown. The IMDS
application will be downloaded and started.

=]|

Warning - Security

Ihe apphication’s digital signature has been verified,
Do you want to run the application?

Manmp: S
Publisher: Mational Center Far Atmospheric Research

From: htkp: ffaoaws, caa.gow. bw

[+ #lean= brusk camkork Frorm Ehiz publishor

Fun Zancel

e The digital signature has been walidated by a trusted source., Mare Information...

Fig. 4.0-1: Window asking permission to run the JMDS
& 4.0-1: FHRRGEEHIT IMDS 138

]

Java Web Start | x|

Verifying application. |

MName: IMDS
Publisher: Mational Center For Atmospheric Research - RAP
Fronm: htkp: ffaoaws, caa, gow. bw

Echirnated tirme ramaining: 7 minatas, 4 saconds

Fig. 4.0-2: Verifying application window
& 4.0-2: BRR|AE
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4.1 JMDS &% (JMDS Overview)

411 EFHER (Data Display)
IMDS HhosE Ik F AR B R AT A 2 i S B SR B T Hb e - HAMET T 200 4.14 £ -

The large rectangular area in the center of the JMDS is used for data display and shows all visible
products and maps with status information. Details on this can be found in Section 4.14 JMDS -
the Main Display.

4.1.2 #EB(Menus)

B P (I AU E (B R AU BEIH - IMDS H ifas e B FI iy - BRIT 2B ~ HIERIEUR
I B A AR e R - HANRT AT 2R 4.2 6 -

The menus give access to configuration and display options. A JMDS configuration can be
loaded, the currently visible products and maps may be changed, the current view area may be
changed, and so on. Details of how to use the menus are described in Section 4.2 The JMDS
menus.

4.1.3 T.H%l(Toolbar)

THEANEEEF 247 - B T ARB R AIFS R B ~ OB BRI i B R &k
RS o HANETA 26 4.3 8 -

The toolbar includes a number of buttons. Some of these are used for showing and hiding
windows, and some are used for inspecting and measuring detailed information in the data display.
Details on this can be found in Section 4.3 The JMDS toolbar.

4.1.4 TRZZE%E (Flight Level Scale)

TRATIZE 2 R A8 4% H AU B R A ab T EE 2 TRATZE I - WA ERTA R VA TR ZE @ 4
J& - SEFRATZE g SRR 7 i N B 2D HYEDR « FRATZE B IS FCAMERT il 20 4.4 £

The flight level scale is used to select the flight level of the currently-displayed products. Not all
products have flight levels, in which case this area will show “2D” to indicate that flight level
selection is not available. The flight level scale is described in detail in Section 4.4 Flight Level
Scale.

415 EfEEE (Color Scale Display)
BT BN B RIE R E 2 P (USSR 2 EE) - HAHEiT 26 4.5 £ -

The color scale display shows the color scale for the currently-displayed product (such as the
color mapping for Humidity). Details on this can be found in detail in Section 4.5 The Color Scale

Display.

4.1.6 BERREI=E4EED (Time and Animation)

W R K B TR H BRI RER E o %8 el 8 H Rl A8 E ez - HAET
TR 4.6 £ -
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The time and animation component displays the current time settings, allows for time changes,

and for the starting and stopping of animation. Details on this can be found in Section 4.6 Time
and Animation.

File_Page Products Maps View Qunfig@IJ
AR 0] z]& =] e k] v E o=@ —

5B /Menus T.E%l/Toolbar

ICAO 5= T H
/ICAO Zoom Tool

TRATIZE 2 %I [ /Flight Level Scale

H F % Bl 125 1458/ Time and Animation
s #E/Color Scale Display

10:352  11:352 12352  13:35% 14:352 15:35¢ 1&:352 17352 18:35%Z 1%:352 200352 21:352 22352

() [ ]

Longer Shorter Dlay Slower Sp Faster

Figure 4.1-1: Major JMDS components
B 4.1-1 : IMDS Fy F T4
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4.2 JMDSHY#ZEEE (The JMDS menus)

%11 IMDS ZEE {7 7Y IMDS 5 & i b J7 30 B iR -
The JMDS menus are located at the top of the JMDS window and are used for several purposes.

File Page Products Maps View Configure Window Help

421 #FEZEEE(File Menu)

RRAY - BN AT BRI IMDS SEREY IR - BlE THEGOE AR AU A s e B
WAEZE ZR T HIEATaERE © a4y IMDS 53 E &g 205 4.15 6 -

Load — Show the list of JMDS configuration files that may be loaded. This includes default

configurations, recently loaded user configurations, or any configuration file on the local file
system. See section 4.15 for more information on JMDS configuration.

HEERIECE -’ IMDS H i f Ve e G 20t - S (EThae 2t = —(E
EETHY IMDS s EfEHIBRLE -

Save Current Configuration- Save the currently loaded configuration file to disk. This gives the
user a starting point for creating a custom JMDS configuration.

VL4 — ) A IMIDS JE T 25K A (4 5 4844 B (Portable Network Graphics » PNG)
B -

Export Image — Save a screenshot of the JMDS into a PNG (Portable Network Graphics) file.

FIENZG: - HIENH A IMDS BURES A © K & SRR BEE AR 6 -

Print Image — Print a screenshot of the JIMDS. A dialog will be shown to select a printer.

;UEIJ)@FE%{% — HIENH A IMDS BUREs i < SAHBR IS - i o SR B eI R BR5 1R
o

Print Inverted - Print a screenshot of the JMDS with inverted colors. A dialog will be shown to
select a printer.

HIERH - BiEGH JIMDS - jETHTAEEBL IMDS 1R & 1E 5 BIEA 2 — RAVRCR -

Exit — Exit the JMDS. This is the same functionality as when the JMDS window is closed
normally.

422 FEEMMERE (Page Menu)

THEmBEE RN (OB E YR - EHE 25 AOAWS Ea Tl AYE R -
FEAE—IFER > IMDS REe8UR B —IHE AL © HBHRSs—HE L > RS REE B AT Ry
FEdh o ER BN G EHAEEBAYIIAE

The Page menu shows a listing of available products. These products are described in the
AOAWS Meteorological Product Manual. Only one product in this list may be shown at any time,
turning on one will disable the currently visible product. Note: this does not affect any products
from other menus.
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4.2.3 iR (Products Menu)

AR PR AL S AL BN © (S EBEE T - BARUE i~ R B HA AL 0 B
AR B P B N H R A IR MY - & r] [ERHEER - B 2% AOAWS ZE i T+l
HHHYZE it B

This menu contains a listing of products that may be overlaid on top of one another. Turning on
products from this menu does not affect any other product and there is no restriction on how many

products from this menu may be showing at the same time. These products are described in the
AOAWS Meteorological Product Manual.

4.2.4 E[FEE (Maps Menu)

AEBEAEEE 2 EEBEHNSIE - CE(EEED > FRERR I8 Ems - B
EE P EETVEINEE R LAIRTRY - & rl[ERGEER - (7 2% AOAWS ZEfm it
HIEER -

This menu contains a listing of static map overlays. Turning on maps from this menu does not
affect any other product and there is no restriction on how many maps from this menu may be

showing at the same time. These maps are described in the AOAWS Meteorological Product
Manual.

4.25 FERIEIEEEEE (View Menu)
2R B - #E 1 &E 2 #E 3 FIR- &R - &8 - &40 - BONEE-0E -~ BoNE
E-57 8 - AR B pign s o F—(EEERH FEEA [F 0Vt -

Global, Wide, Domain 1, Domain 2, Domain 3, FIR, Region, Taiwan, Taipei, METEOSAT 0
deg, METEOSAT 57 deg — changes the currently viewed area. Each of these options zooms to a
different geographic region.

E—EEHE - AU E—FEanUR o (8 H B IETIRE A R A SR A DR g LAY
EERER A [E] i o

Last dataset — Switch to the last viewed product. The keyboard shortcut associated with this
action can be useful when two products need to be compared to one another.
4.2.6 E¢EEEE (Configure Menu)
I [ B Bl — BRI R b B e e v
Time and Animation — Open the time and animation configuration dialog
NS I
B S a e A EEE YR H DAL IMDS BEEEURER 2 T HE - 45 {I8 Ry ] #a & [F)
e BEIFER A - I s B e A B8 R AR - IRl s B4R R ~

BIERE - EELRCEEHIER > HENBUNHEER RN ESER (Results)EBE
l:'j o

Displayed Time Range

This section includes elements to configure the time range of selectable data for the JMDS.
This time range is also used as the animation time window. The time range is specified by
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the frame interval, the end time of the range, and a number of time frames. As these settings
change, a preview of the displayed time range will be shown in the Results section.

E2Jj

SEMI SCETENER R WISOE - I EE (Frame delay) ForEERE] 1Y 5/ NI © 2
D AR i PR ey B 23 - 2R BRI (Movie dwell) R EBERIZ R
25 45 AR B E R R I & fe/ NI PR ]

Movie

This section allows the configuration of animation/movie settings. The “Frame delay” is the
minimum amount of time between each frame of animation. This may be changed to provide
for faster or slower animation. The “Movie dwell” is the minimum amount of time that the
animation will wait on the last frame of the animation loop before continuing to loop from
the beginning.

co(( B ) Sl

Displayed Time Range

Frame interval: 1 :Hours [«]
Number of frames: 12

End time: [2012-11-151§ ...

Results
From: To:
2012-11-15 06:20 2012-11-15 18:20
Display:
[ | | | | | | | | | | |

7:20Z 9:20Z 11:20Z 135:20Z 15:20Z 17:20Z
11715

Movie

Frame delay: 100 i.Milliseconds'!v

Movie dwell: 2500/ |Milliseconds |w

oK | Apply . | cancel

Figure 4.2.6-1 :Configure animation
4.2.6-1 : BIERCE

METAR #3238 : BIEH A8~ IMDS iy METARs #3735 - EABEGE RN
METAR #oCGEIERESE RERm ~ BERE - EUR - MR BDE SR/ ME i K EE
# o BERGETHBEGAE - METAR £fay DUSS — RS R R AR FEHVBE Cu A 1T 4 [
HATFE SRR - FEEHE HEIERRT - SRR E S IE » AIER ~—IH
e o PR BR R (OB IEARE R IRE T » EFIFTAE IR O ERE - B—IHEERRE
HIBL IR e ] F R B2 32 5 | SRR 5 AN BB /e (AR — S B s A

METAR Filtering — Opens the configuration for the current filter set applied to METARs
currently displayed in the JMDS. A METAR filter is associated with a color, and defined by

several minimum and maximum value criteria, including ceiling, visibility, wind speed, relative
humidity, and temperature. If the first filter’s criteria are true, the METAR is drawn with the color

o
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associated with the first filter. If that filter is false, the second filter is applied. If that filter is also
false, the next filter is applied. This continues until every filter has been tested. The order in
which filters are applied can be modified by clicking on a row/filter and then clicking one of the

arrow buttons in the left panel.

only show METARS where:

Re-order
Selected v
Filter

(B || ]| /o8]

Descriptiaon

come [ o] [ ] _owie |

(2] Add a METAR filter ===
Ceiling (flight levels) maximum: | | | mimimum: | |
Visibility (m) maximum: [ | mimimum: |
Wind speed (kts) ~ maximum: | | minimum: | |
Relative Humidity (%) maximum: | | minimum: [ |
Temperature (C) maximum: | | minimum: [
Color: I

OK || cancel Reset

Figure 4.2.6-2: METAR Filters configuration
4.2.6-2 : METARS #3038 5E

FEERAYE © FEEE R AGHEOE - (EHE T BT ERE - (HEEEREK

FIERST dBZ {H - I H o] DS et A IE H Y 23

> DU E GRS PA & S B R i -
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Radar Warning Configuration — Opens the configuration for the radar warnings. The dBZ
threshold at which the warning is triggered for each warning region may be configured, and
individual warning regions may be enabled or disabled with the check boxes.

| £ Radar Warning Areas M

Active?  Region Name DBZ Threshold
. RCSS airport [30 |
m RCTP airport M
m RCKH airport M
. RCFN airport [30 |
m RCGI airport M
. RCLY airport [30 |
. RCKW airport [30 |
m RCBS airport M
. RCMT airport [30 |
m RCFG airport M
] RCQC airport M
. RCMQ airport [30 |
m RCYU airport M
OK Cancel Uncheck All Check All

Figure 4.2.6-3 : Radar Warning configuration. Actual radar warning regions may differ

4.2.6-3 : FHIFEEOREE, HIRAE BEEOREIREBOE N TTRES A AR,

BHEE - R ERAEARCE SRR o BRI EREREN - BA RS
N A FHVEIE &R A &8~ IMDS | -
Incident Reconstruction — Opens the incident reconstruction mode configuration dialog. When

incident reconstruction mode is enabled, only data that was available as of the incident time will
be shown on the JMDS.
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E Incident Reconstruction M=

Incident reconstruction mode enabled

Incident Time

|2EIEIT-“I 0-18 21:27:43

OK Cancel

Figure 4.2.6-4 : Incident Reconstruction setup

B 4.2.6-4 : BAEETRE

WS TR - PRV TR B ST - A BT B TR R R ] Z S5 TS5 TR &
KPEEREEE - E - TS - KA - FIIRE - EURIRER) - BRCHESS s s
Z AR R PART A 4% i 0 78 SR mn e TR B RAPANT IS - &8 BRI E
AFLEE |7 (] —(E 58 B0 [ 705 > IMDS & B sk TR i > % TR S el T -
TAF Selector — Opens the TAF Selector dialog. Several different TAF data layers may be shown
(All, Clouds, Tempo Clouds, Wx, Tempo Wx, Wind, and Gusts) for forecast periods into the
future. Opening the TAF Selector turns off all gridded products, and these products are restored

when the TAF Selector is closed. When the mouse cursor is placed over one of the TAF options,
the JMDS shows the appropriate TAF layer at the selected time.

< | TAF Selector T

View TAFs
212 All Wx Tempo Wx Wind Gusts
00Z All Wx Tempo Wx Wind Gusts
032 All Wx Tempo Wx Wind Gusts
062 All Wx Tempo Wx Wind Gusts
09Z2 All Wx Tempo Wx Wind Gusts ||

Figure 4.2.6-5 : TAF Selector
4.2.6-5 : RS TRERBEEE

4.2.7 THEGHEEE(Window Menu)
I T A B AR AR RS MYy 7 =B R 15 2

This menu provides an additional means to open several of the display sub-windows.
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= H I EE - AR E S HERE - 2 2a #5 S RS B TEE - A
REIEE R -

Vertical Cross Section — Shows the vertical cross section window. No data will be shown if a
cross section has not been chosen with the cross section mouse tool.

FhmE - BB BERURRUR B E -

Skew T — Shows the SkewT window if it is not currently visible.
TS TR B — RIS LR BE BRI S TR B B B 2 -
TAF Selector — Opens the TAF Selector dialog.

4.2.8 EiBHEEEE (Help Menu)

SEHI - FIBAAS AN & -

View Help — Opens a window with basic help information.
st — 78 IMDS A il T a4y &R I & -

About — Opens a window with detailed information on this version of the JMDS.

4.3 JMDSI.EZ%I (The JMDS toolbar)

File Page Products Maps View Configure Window Help

[alalale] 2laEwms elk]velE o=@ [0 [luzenm,]

Figure 4.3-1 :Tool Bar
& 4.3-1 : THEFY

It IMDS T B 7 FR R FEGET 2% N TR » AROK ~ P8 - 488 hati - BEEE R ITAr
FILUE Ea e HE B e S - BT EAER—REAN RaeA —EHEE) -
The JMDS toolbar allows quick access to many commonly-used actions. The Grid Inspector,

Distance and Azimuth, and Cross Section tools affect mouse behavior and only one of these tools
may be in use at any time.

4.3.1 HEHEThEE (Zoom tools)
JMDS U4 T H - &5 0] AR B R8I RHVIEE - MHFHEA 2 ARAS T A H
iz e

There are four zoom tools, all used for changing the currently viewed area. They are described
from left to right.

R K - B SR A EAEM TARNTE TR - SEHEHETE » AR5 B/
i R ABOR A -
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Zoom In — This is the default tool that is used when no other tools are enabled. When enabled,
this tool zooms to the area defined by a mouse drag with the left mouse button.

Q b (EEEE - SO 8 R As Y b — FAE - AR EIE E—(EEENRRE - 5 Ak
—{EHE - Az TEAGAEN -
Previous Zoom — Similar to a web browser Back button, go back to the last zoom state. No action
is taken if there are no previous zooms.

R T—{E#HGE- A E R E S N — s - HZRE T —(EFEIRRE - E2A N —
{E&E - Al TEAEAEER -
Next Zoom — Similar to a web browser Forward button, go to the next zoom state. No action is
taken if there are no zooms to move forward to.

i PR - EEAEETE  f 08 B/ i AT PG R A s I

Pan — When enabled, the left mouse button may be used to drag the viewable area to a new
location.

4.3.2 EmEE TE (Cross Section Tools)

1 e R B g — (R e AR B P B H R b [ - T R B SRS IAE R 51/
Bt -

The cross section tools allow a cross section of visible data to be selected and shown in a separate
window. See section 4.7 for more information on cross sections.

e

b | EE TR - SEAEETA > WERERAHREER I R o BRRAEEHE TR
AR PR T8 B SR B (78 B G S B84 Show Cross-section” « & FE{E5E R » 55
—ERE T GRS ERTA R ZE B E R -

Cross Section Tool — When enabled, this tool allows the selection of points along a path with the
left mouse button. The path may be finished by double-clicking with the left mouse button or by
pressing the right mouse button and selecting “Show Cross-section”. When the path is completed,
all the data along the path specified at all flight levels will be shown in a separate window.

(o

S | bk 2 R T -5 5 RS TR T L SR B — (67 PR A AR A s (5%
WEHEACERREI A ISR (4)7) BzE B PR RfERE - & BRI SEpifg AL s (Apply) » Z5—{E
e g BURES TS T AT ZE Y &Y -
Station Cross Section Tool — When enabled, this tool opens a window that allows the selection
of a path by station identifier. Station identifiers must be separated by commas (“,”) or spaces.
When the path is completed and the Apply button is pressed, all the data along the path specified
at all flight levels will be shown in a separate window.
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lE'Sl:al:inn Cross Section Tool =]

Enter VORSs, ICAOs and Stations

List identifiers seperated by commas and/or spaces

IRCSS,RCTP|

Apply Cancel

Figure 4.3.2-1 :Station cross section tool window

] 4.3.2-1 : JnhEEE T ESE

4.3.3 THE T H (Window Tools)

e THE A ARE IR RE H e - S LH SHES—(ETHE - EiEsntisk
Ry AT LB A IR L 2 A e R a8e B (L B BRI PRI R L F e SR ERG 88 - A2 N5y 5T
#h - A ETAR B T RYCREE - NIt~ g A E MR ERURIE IMDS L -

The window tools show and hide separate windows. Each window tool is linked to a sub-window,
when the window is showing the button shows as being selected, and when the window is closed

the button is unselected. In the screenshot below none of the window tools are selected and
therefore none of the windows are showing in the JIMDS.

HETHEES NI%IE
The window tools include the following:

(]

EEE 7 7 | = [ — s / N oA 2
1) figt5 1%y METAR R T B — BURHIFEE s 1e 1y METAR SR8 - HANET A 26
4.8 ffi © (Decoded METAR Table Tool - shows and hides the Decoded METAR Table window
in section 4.8.)

W

EEE —_ S |= e — o e N > A &
2) EHZE B RE SR TR - U IR = 22 U500 Rk Ge - HAllfinT 26 4.9
g1 » (Winds/Temperatures Aloft Table Tool — shows and hides the Winds/Temperatures Aloft
window in section 4.9.)

X
= 3) TR e A T E - BURAIRS s it A i S e i g - FLER

n] 2R 4.10 £ - (METAR Time History Tool — shows and hides the METAR Time History
window in section 4.10.)

Y4y SR RS R T - BT RS S R R S LR o HLAmET T 2R
4116 -

(Time/Height Profile Tool — shows and hides the Time/Height window in section 4.11.)
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L]
Vis) meeere BU/ALREIT A - ErAISRE s B AL RE e » LIS 412
£  (Virtual Sounding/Skew T Tool — shows and hides the Virtual Sounding/Skew T window in
section 4.12.)

HO)FIFPAI TR - PP T B @R - © A LUCaT(E & e e ERGEE(E—
B o B {58 RN [ T2 s ED T RGBT [E1E - RISy IR e K H AT Page
BEEE [ PTERNR S L - BUREZ RIS P& L o (Time Series Tool) When enabled,
the Time Series Tool button allows a location on the map to be clicked. When the map is clicked

with this tool enabled, the time series window will be shown with a time series of the currently
selected product from the Page menu.

TAF

B 7yos s TE - B REIRS RS TESHR IR - (TAF Selector Tool) — shows
and hides the TAF Selector window

4.3.4 E:H T H (Informational tools)
T &R T EIR AL E YA BE IMDS BURHIERIH -

The informational tools give additional information about products displayed in the JMDS.

L B LR - EEAEHETAER - REUREZ EEPATA n RV R E - Bk
SHREAVE R SRR -

Grid Inspector Tool — When enabled, this tool shows the values of all visible grids in the map
area. Missing or bad data is not shown.

[T
PR 5 JTAL - S FE ST TR - FV8 B /e s A ] SR WG - o & B RG] Y
PEBE R ITAL

Distance and Azimuth Tool — When enabled, two points may be selected on the map with the
left mouse button and the distance and azimuth between the two points will be shown in the map
area.

435 E'EH T H (Reset Tool)

(V) . . AP,
EE T AL H ARE AR E AT IMDS - (AR EE s o SRR
Z BB R AN
The reset tool resets the JMDS to the current configuration. Any unsaved changes will be lost.
The JMDS will display the default setup region and product.

436 ICAO (FIFEEMi4HEH T (ICAO Tool)

ICAO T ALK ERIE A ICAO Bk REEHIRIBIE L - BUA ICAO
kRS Move To"HyZHIZEA % » B MU SR TR B 3%
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ICAO BEHEASRATER S, -

The ICAO (International Civil Aviation Organization) tool centers the view over any worldwide
station with an ICAO id. Once the ICAO id is typed into the entry box on the left, the button on
the right may be clicked to change the view to the location of that ICAO id.
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4.4 TRAZEJEZIE (Flight Level Scale)

= BT (R
122 )
Altitude units —
(flight levels)
N
fi]
b
S
8
2
8
=
R
i FrisEtEm & (FL250)
SR

Selected altitude (FL250)
Selector button

(Buroeds 1 0001) FHZLFH |

4.4-1 : TRAZEIB L BEREOR B AR TS 4 FL250, TRMTZS 8 nl 184 1/t & /)N 4 FL10 ElH K74 FL430

Figure 4.4-1: Flight level scale currently showing a selected flight level of FL250. Minimum selectable altitude is FL10 and the maximum
selectable altitude is FL430



AOAWS JMDS Users Manual 20 JMDS Operational Guide

TR ZE JE 212 AR RIS 2 H BB A Y TR ZE JB . » A 2T Y i &L S e
ZEJE iR o B RS AT RV BRI B AR AR ZE e e E - H AR TR ZE e
R —Efe GV BRI - BRI 2 L A SR B

The flight level scale is used to view and change the flight level of currently-displayed products.
Not all products have a flight level component. The available vertical levels of the current
product are listed and the current flight level setting is chosen with the orange selector button.
The current flight level is shown in orange, and the available selectable flight levels are shown as
white lines.
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4.5 @EEE R (Color Scale Display)

T g - i - EERS R 110 2
2 LAY GRSH) 120 JH 2 fE & LAk (TS
Product units (knots) Color bin. Values between 110 and
120 are rendered in this green color

Figure 4.5-1: Color scale
4.5-1 : tARERR

4.5-1 Ry VR FE SaFr(E Y P& B8R - SRR HATE RAVEmIVEIE - 41 LE -
JRVERE i s & DA [FIBR O Fon A EIRVEUE - B0 - Fra RS AL 110 2 120 JE 2 fE g Ll
RO - CIEBUNEEE N EEMIMREE - _EEHE R Rz S (8 Y g8 -

Figure 4.5-1 shows the color scale display for the wind speed product. The color scale display
shows how the currently-visible product values are rendered. In the image above, all values for
the wind speed product will be rendered in the colors indicated. For example, in this case all wind
speeds between 110 and 120 knots will be rendered in green. The color scale display will update
whenever a different product is shown, so this color scale is only shown when the wind speed
product is showing.

4.6 HEfE M EhEEH G (Time and Animation)

Pakdl | I ! ! ! ! ! ! ! ! ! — —
10:557 111:552 13557 13552 14557 15552 165527 17552 18552 19552 200552 271557 22557
Longer\ Dwvell £ Sharter p Slowar SpeT Fasta
LR A R B2 1 B R SES ]
Now and Selectable times Start/stop animating Animation speed Current Time
|

EE=VERNEE EE=YEAEtist ENESSE ST

Move start time Animation dwell time Move end time forward or

forward or back back

Figure 4.6-1: Animation time selections

4.6-1 : BhEIF A ELGER E
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JMDS 47t AT Y M B 5% B an Se B e - s (M4 R ] DAR AR S B AR E -
T EIEIAYE 4.6-1 o > PEfGEhAY EEE0ey Ry H piseE iR g - 1L EA H A EE R
[~ APEEREAYIFREIAR T o 2RISR ok nl SR 6 A = R B B PGV R T A B . 15 8
11 B R i 22 Y A e B AT DR B S 45 TR R E AT BT 18 158 - BRAERYEEEEG R DL —{E R
ARG E & TR » 1T Now §258 Al & 5 24 B REBURIRAE RS [ Y &k -

The time and animation portion of the JIMDS displays the selected time for visible products and
animation settings. This component also allows these settings to be changed. In figure 4.6-1
above, the top portion of the time and animation component deals with the selected time and the
selectable time window. The pair of arrows on the left of the time window allows the user to

move the start time forward or back. The second pair of arrows on the right side of the time
window allows the user to move the end time forward or back. The current selected time is shown
with a large orange box. The “Now” button takes the users to the current time.

FEHECA DACE “BAR” HEsHRUY - BUTEIER - iR i %8 - KR[E IMDS
IEEE RN (R - BIENERE LU A E I E (BERFEERY 2 EHIRHEE )
Al E PSR TR -

Animation, or “movie mode”, may be enabled using the “Play” button. When animation is

enabled, a “Stop” button appears which will return JMDS to normal (static) display mode. The

speed of the animation, as well as the dwell time (amount of time to wait between animation
sequences) may be adjusted using the appropriate sliders.

{8 & Al s e ZE B 3 e B oy b/ D AV ] e B2 T fF - WEh=E R IR o o]
2H 4266 -

Some less common elements of time and animation may be configured through the Configure
Menu, such as the delay between animation frames. This is described in section 4.2.6.

4.7 HEE (Cross Section)
Cross Section _h 2 X

File View |
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Figure 4.7-1: Cross section

& 4.7-1 : 2 &

1 T 57 R 72 o 1 T = 25 8 7 5k b 1 e ] R it 3 o ] T L A48

W14.3.3 Gifril - BnEREEATAERKE LEESE - HAlTERRTZE BT

AR 81 IMDS 5 P RTRATZ B 2 B A HEIRVIIRE © fE5 U@E?ﬁ‘?ﬁ@ﬂ%ﬁ%%
FEREREHIRAZE LSRR - # e O W (R & AR 22

The cross section window shows a cross section of a product. The cross section path may be
chosen with either the Cross Section Tool or the Station Cross Section Tool, both described above
in section 4.3.3. The displayed data includes all vertical levels along the path. The currently
selected altitude is shown on the right side; this is equivalent to the Flight Level Scale in the main
JMDS window. Changing the flight level selection on either this flight level scale or the main
flight level scale will change both flight levels.

GRS EImRAT AT BRSBTS AR BN & LT - BT A HTRMENTAT - BH
S(BA%R) ~ EGER) ~ FIEH A AU - 5B E IMDS 215 & F AU S i Bl
& ERyATEHE -

If there are nearby waypoints to points along the path, the waypoint names will be shown at the
bottom of the cross section window. If no waypoints are nearby, “S” (start), “E” (end), and
numbers will be used to label the waypoints. These names will correspond to waypoint names
that are displayed in the main JMDS data display for the cross section path.

BTEIHER > SRR Y H BT o M) B R E R (HRESK IMDS &
EHRF SRS LR o FrE MIMIRS I E (S8 E Y IMDS 558 e A& o) o] DA H = B3 1 5 e B
HY V iew=>Classic menu RO o

Cross section paths are automatically saved as they are created and may be recalled through the
View menu. However, these are discarded every time the JMDS resets. “Classic” Flight Paths
(as configured in the JMDS configuration file) may be selected from the View->Classics menu in
the cross section window menu bar.
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4.8 fRIE%IIMETARSE (Decoded METAR Table)

Decoded METAR = for RCTE

S=/E3

Home | Time |"Wdix'W=pdWg Wiz Weathex Ceil TempDewp QNH

deg | kt | kt it FL [ r hPa
RCTP 0400 020 009 Q000 030 022 1004
RCTE 0230 020 008 Q000 030 022 1004
RCTE 0200 010 007 10k+ 030 022 1005
RCTE 0230 360 007 10k+ 030 022 1005
RCTE 0200 350 006 10k+ 029 022 1005
RCTE 0130 020 005 10k+ 029 022 1005
RCTE 0100 260 10k+ 029 022 1005
RCTE 0024 020 10k+ 023 021 1005
RCTE 0020 010 Q000 023 021 1005
RCTE 0000 020 annn 027 021 1005
RCTR 2227 240 5000 HZ 023 022 1006
RCTE 2230 230 a000 027 022 1005

Figure 4.8-1: Decoded METAR table

4.8-1 : fiRiB% P METAR 3

1% A METAR 20 &5 FH 85 {18 A i e (i AR B AR H B —H5URTRAT 7/ N YT &

BB S S BHENS » FB BT IMDS 18 25 (1o BB & 5 a4 [ i 1y

— =z

TNHE

Na)
¥t -

The decoded METAR window shows several decoded fields from a single METAR station over
the last 6 hours. When this window is open, any left clicks in the main JMDS data display area
will update the location of the displayed data.
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4.9 =R FORE 3 (Winds/Temperatures Aloft Table)

B windsmemperatures Aloft  [BIE)E3] BESEEESEC L RUID)

Data time: 200710719 21:00:00 UTC P

(Lat, Lon) : (23.3146, 121.2368)

Closest nav point: ITYA

'H{gh:‘ wdirn | Wspd ‘ Temp ‘ Dewp
Tt degT k1= . . # .
450 282 42 -a7 -82 11 E‘*‘Hﬁﬁ

50 RN TR S 430 239 44 -63 -7/ 16 (location)
i (closest nav point) 4o 257 46 -8 -7 20

340 259 a7 -55 -6 18
370 261 48 =40 Ealal 15
350 205 49 -45 -63 12
330 2087 49 -39 -a0 11
310 208 48 -34 -5a 10
240 268 45 -29 -51 11
280 208 43 =27 -4 11
270 268 42 -24 -4fa 12
280 288 4n =22 =24 13
240 268 39 -19 =40 14
240 289 38 -17 -37 17
230 270 37 -15 -33 20
220 271 38 -12 —-30 24
210 272 35 -11 -2a 24
200 273 34 -9 -22 35
190 275 31 -8 -19 40
180 27T 24 -0 -1a 44
170 2E0 25 -4 -14 4
1a0 283 21 -3 -13 45
150 284 18 -1 -13 41
140 280 14 0] -13 37
130 291 11 2 -13 33
120 295 7 4 -12 32
110 07 5 ] -10 32
100 3G 4 7 -8 34
=14 36 5 g -7 32
B0 s =] o =10 25
o a2 14 10 -14 18
ar fd 18 10 -13 19
S0 a2 22 10 0 51
40 53 20 10 10 = 1=]
30 51 27 13 12 Gl
20 a0 27 1a 1 B
10 49 27 19 13 it

[ e
Figure 4.9-1: Winds/Temperatures Aloft Table

4.9-1 : BZERIG LB EGE

1o 22 B SO AR R B T B U — (B BERGHY WRE ARk - AR
JRVER ~ O - BRRNIMHENRE - BPHEICR RS E o EEE AR > HEEARAE
IMDS £ 1 B 52T R & S % IS B R &R ©

The winds/temps aloft table shows a tabular listing of the forecasted profile (WRF model) for a
single point, including wind direction, wind speed, temperature, dewpoint, and relative humidity.
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Each row represents a different altitude. When this window is open, any left clicks in the main
JMDS data display area will update the location of the displayed data.

4.10 FEEEHE ARG R 251 B (METAR Time History)

m B3 VETAR Time History

Print
RCTP Ceiling (ft) 8000
——

a—— T — ey -~ e

A i i i i s ' i i ' L L 'S D
IRCTP Visibility (km) V_’_'_,_/—/_, 10,

\x —

L ' 'S A A ' 'S A A ' ' 'S 0
RCTP Temperature (C) 27

AN

L ' A A ' i ' A L A A L 22
RCTP HUMidity (%) s—m—m—— — 0

? i ; : i : ; : ; i : A 0
RCTP Wind Speed WS

' ' ' A ' ' AL A A ' ' A 0
|RCTP Wind Direction (T) 3eo|

sttt _— i ———— e e — —
|[RCTP Pressure (hPa) 1019
D8:00 12:00 16:00 20:00 00:00 04:00

M 2

Figure 4.10-1: METAR Time Historywinds/Temperatures Aloft Table

4.10-1 - &5 b LRI I ] Fr 471

Fes Tt TSRS i e 5 [ 157 9 B B[ 20 B BE — R 5 R b 2 - DU/ NS A St T AR
WA E - B AR LAY E RS EE T JRIE -~ R - R - EE SR B o B E(E
BRI - FVE B /C SRR E IMDS AR & AT R & B0 3 IV T &R -

The METAR time history window shows the time history from a single METAR station over the
last 24 hours. The active fields are: temperature, humidity, wind speed, wind direction and

pressure. When this window is open, any left clicks in the main JMDS data display area will
update the location of the displayed data.
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4.11 =S w2 LEl (Time/Height Profile)

Time/Height Plot _

Humnidity Time/Height ] --- 450
50880, 121.2423) - From 0Q/23/08 16:25Z To 0/24/08 04:252

S 390

[
I L 330
. L [ L

280

280
220
140

ACm

[

130
RH: 84.0620 % 100

at 23:00Z 9723008 at 160 FL 07
040
010

20:00Z 0:00Z 4:00Z
9123 9/24

Figure 4.11-1: Time/Height Profile
[ 4. 11-1 - g J3E 1 i R i 2 o

v B R ] B LR R B B0 H AT AT A6 3D b/ NRF PR SR DR 5 H AT Al 1R i 2
AEEHEN  HAGENERLH RS LR E S e o e (A EbHRr - HE
B /C S AE IMDS A5 B (]RGS & B 3% IR BN ) © B P A VAL R By
H ATk -

The Time/Height window shows 12 hours of historical data for the currently visible 3D product.
If the currently-visible product does not have vertical information, no data is displayed and an
alert window is shown. When this window is open, any left clicks in the main JMDS data display
area will update the location of the displayed data. The red mark in the time portion shows the
current time (now).
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4.12 EfERZE E/RLAE (Virtual Sounding/Skew T)

L i A N
KXY“X\K\//\

YWirtual Sounding: Anal 5|s‘ufaI||:I at 06 23 08 187 o

al Soundi

Figure 4.12-1: Virtual Sounding/Skew T
4.12-1 : HEBEIRZE18]/FHE

RIE =28 i OB BB ZE B (RDAE) - A EE T DUERER R & E B e YR a - 4143
FTRIE SRE o GGERE “BEY o EiE(ER RN - S E/ASEE(E IMDS £
TR (1 {n] Bh BE S R W e I B B R -

The virtual sounding/skewT window displays a sounding plot (SkewT) based on winds and
temperatures aloft. This window also shows the wind barbs of each vertical level displayed in the
plot. The red line indicates temperature and the green line is dew point temperature. When this
window is open, any left clicks in the main JMDS data display area will update the location of the

displayed data.
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4.13 BFfE 251 (Time Series)

BT - ] ABURAE Page BEEE (LRI SR G fnHHRF ] e A1 - HRp ] e 5l =)
FEASABNOLE K 2 s b - (EHER B RERE L - WY E TR SRR
12 /N > (B AT LIRS P 5 0 e el s o ERAh - BRI e A e R L B A
GAEEEA LARHAK -

time series for multiple locations and products may be shown together. 12 hours of
data is shown by default, and this may be modified in the time series window. Time

series locations will be marked on the main map.

ile onfigure

5 [ BRI 815 £9/Change

=

58.33
& 5758

altitude units window

Time Series 0
Wind Speed
Winds - - - #— - -

5503 om 55 35 - / \

FFFE] 4 8 15 29/Change - \

time window \

T \
= N \

50.8?:' £ 50.89 L

| | | | | I | | | | I

110002 12:002 13007 14:007 15002 16:00Z 17:002 18007 19007 20:007 21:00Z 22:002

1220

Data Layers | Awailable Data Sets

o Time Series 0 Longitude/Latitude: 120.6492/24.8406

Figure 4.13-1 : Time series of radar data

& 4.13-1 - HERFHIRRFSE
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4.14 IMDSH F BE R £ (JMDS — the Main Display)
ARRE R EE b B AT

Status and product information

122E

EESHR e 2HLR
Latitude reference lines Longitude reference lines

Figure 4.14-1 - JMDS - the Main Display

B 4.14-1 : IMDS B ERERARE
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IMDS T HE R URER T 23R HATE I - BUREISHAE/ G ERE - NI A
FYFHBHIRRS -

The main data display portion of the JMDS shows the current product, the
longitude/latitude extent of the viewed area, and status associated with viewed

products.
BRI S
Displayed status information includes:

BEVHYRFR] - IMDS H g A © BT A] G an SRR S (E R i AR R &
T} o B R EhE Tt g [E BB~ (E B AR ] -

Selected Time: the currently selected time of the JMDS. All visible products show

data based on this time. This is also shown in the Time and Animation component.

FEOnE RN ¢ FRE AR e R ARV EER - S BURNE R - BURERIHIIR
iz CER) ~ BREE - SERIE IR SR - £ EET - E &R
HESC RN/ B o & 7 hnbE BUERRHEE L%B/\:””\Eﬂ@ HIEE IR -
BEEAEIRRE S Y 1) T Fi 9 A8 B st i R RE AL A ARG I

Product Information: information on each visible product and grid, including the
time of the displayed data, the flight level (if any) of the displayed data, the data

domain of the data, and errors related to loading the data. In figure 4.14-1 above,
product information includes the white text at the upper left. As products are turned
on and off, this information will update with more or fewer entries. To view the
status of maps and other static data as well, click on the down arrow below the status
text.

PRE SR/ PR RSN BRI N BT H AR e R R ] ] - IMIDS
SRR S R TS © RSN TR AR R A MBUR R A G B &R B
H AR T G B A S - BEEE R R AR AR R Bt T ERAE T2 S ] BB TR
AR SR

History/Forecast Mode: the JMDS is put into history and forecast mode when the
selected time is not the selectable time closest to now (the current time). Both history
and forecast mode indicate that the display is no longer checking for new data and the
current time window will not change. To leave forecast or history mode, select the

time closest to now or press the “Now” button.
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4.15 IMDS 2478 5% £ (JMDS Configuration)

ZHRENR - R XML AS A SEEREZE - B R e E R SRR 21y
BUTVIRRE * e A/ ~ LB~ BEEFIBURE RS AL - IMDS S 42
Y B E AT W8 P2 RS TR i & H C R Sa e HURERE - AL R iR BT %
e NG G Ealny B HsEa W o 78 N 4.15.3 81 > R BtERAIey £
S ERSZEAETERA -

The JMDS is configured using an XML configuration file which is loaded at startup.
These configuration files control numerous aspects of the display, from window size,
placement, and colors, to detailed descriptions of the datasets available for viewing.
The default JMDS configurations provided can be used as a starting point for
developing custom configurations. The default configuration files are heavily
documented within the files themselves, and are intended to be self-explanatory. A

brief description of the configuration file structure is provided in section 4.15.3 below.

4.15.1 FEH A4 5% EREZE (Loading Configuration files)

IMDS Z &R I S AECERE S - KA RS A O RRECEREZE - TTFIH
fEZE(File) >R HUEE B (Load menu) Ria EFEZESH A IMDS Z:47 > B8 A S35
EREFR - ZAUkg B AR - R ARRCERG AR -

Default JIMDS configurations, as well as custom configurations located on the end-
user file system, can be loaded into JMDS using the File->Load menu. Loading a

configuration file resets the application, and any current settings are lost.

4.15.2 FFRA M 2455 E 18 (Saving the current configuration)

—HEARSSUERRZER - ATHHEZFile) ->{#{7 2 B (Save menu)f 2 4T30E
T2 AE H C H BV ZE (local file) - [LEETFAVIEZE AT (i S T 4R g s
R - FREHTAE A IMDS 245 -

Once loaded, a configuration file can be saved to the local file system using the File-
>Save menu option. Saved files may be customized using any text editor, and
reloaded into JMDS.

4.15.3 Z 4 EREZEERBH(Configuration file description )

IMDS Z&tas e e (o0 FH 2 o A XML A (XML AS R - m e
L HZ 4R 25155 - sAIpiEayEi s - IMDS 24t iy 4t e iR 2 B
W IR S - IRME B RIE S B C ARG EHTIER - Z805E
FEZE AT 3 LA T 2% N
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JMDS is configured using the widely used XML standard (for a description of XML,
see any of a number of online references on the topic). As stated previously, the
default IMDS configuration files are self-documented and a good starting point for
developing custom configurations. Briefly the configuration files are divided into the

following logical sections:

o [BRESE - FTA &k EmEiESEEE TS MR0E - BREREER
URL {7 & ~ 88 - BURAME - IFREEHERIREE - SEERIVEE
WAEEHEE

e Layer Configuration All gridded ant non girdded data products, as well as
static maps, are defined here. Options include data URLs, field names, display

names, time selection strategies, etc. Data-specific options are also configured

here.

o FRUHECE - BEE N A RAVEHHAME ST - EAYFEZ EEAEM
(Page)JCBEHE ~ /i ISR B (Products) ~ K S| ZC5E B (Maps) FIAE iS4 14
EE - DSl A A B R S HEIVAE S o 28 it o] DA SR B
(& T SRR - B4 A (S ] B AH o] DA AR o] 1 R AR ESH B AT
HeFAREEERS ©

e Group Configuration Menu and visibility groups are configured here. Sub
menus of the existing “Page”, “Products” and “Maps” menus can be defined
here to help organize available data products and maps. Products can also be
grouped into visibility groups in this section as well. For example, a group of
products (or maps) can be turned on/off simultaneously by grouping them into

a visibility group

o Wi~ BfE - B - HERERSCE - HRBRAUN  BURLE ~ BRI
ReleE: ~ = FE B AL R P 5 2N BETH AR LB B E -

e Time, Animation, Altitude, Window, and View Configuration Options
related to display size, position, colors, time zone, altitude units, and view

projection are defined in this section.

o EERIERE - B E E R A LA S -
TR E R E T R G/ - R A A E
R IEEE T L M, -

e Area Configuration Areas of interest are defined in this section. Each Area
defines a lat/lon bounding box to display in the plan view, making it easy to
zoom to pre-defined map regions by choosing the desired area in the View

menu.
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o THEE - ¥ARE IMDS T EETATE ILETHEE » svEH HERE

e Tool Configuration Options for the various JMDS tools are configured here.

These include:
o ElmHi[E|(Cross Section)
o 7% [El(Time Series)
o FEEEMZH[E|(Radar Warnings)
o RbR/EEEHEZEE(SkewT / Virtual Soundings)
o HFfH)/ = fE El(Time / Height)
o ERE- BN FE MBS E R BT EUE -

e Colorscale Configuration Colorscales for the various gridded products are
defined here.



